How to use ICC12 with Adapt912DT60 and FLASH Loader

This document will show and demonstrate the use of ImageCraft ICC12 Latest
Version 6 with Technological Arts’ Adapt912DT60 module.

The FLASH Loader written by Technological Arts and can be found inside the
starter package disk. The file can also be downloaded from
http://www.interlog.com/~techart/myfiles/files/12disk4.zip website. The
FLASHLoader will be used here to erase and program FLASH after the
compilation of a test program. Other method can be used to also erase and
program the FLASH but in this example it will be the FLASH Loader.

This document assumes that the user is familiar with C and so will not teach how
to program C here.
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Getting Started:

Double click on the ICC12 icon. If a user has not read the ICC12 manual and
just open the IDE one will wonder what to do next. Well wonder no more.

Note the 3 window panes. The top left most is greyed out and the right is the

project window. The left bottom pane is where the error messages are displayed
during compilation.

Before creating a new Project, the hardware target in the Compiler Options must
be setup properly for the target MCU. This is to ensure that the compiler will

setup the type of MCU the C program will compile for. In this example it is the
Adapt912DT60.

* ' ImageCraft IDE for ICC12 {PROFESSIONAL) i [m] |
File Edit Search “iew Project RCS  Tools Terminal Help

g |+ 6|8 adzEE

|[ Mo Dpen File | |[ Mo Dpen Project |




Compiler Setup:

Click on Project Menu — Options — Target Tab.
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Please note the Device Configuration. Click on the pull down arrow to change

the device type.
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Scroll up or down to select 912D60/A as shown.
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Device Configuration:

Program Memory: 0x1000
Data Memory: 0x200
Stack Pointer: 0x800

The program code is allocated to start from 0x1000. The internal RAM is to start
from 0x200 and the stack is to start from 0x800 and work downward.



On the compiler tab there are several choices of S-record output as shown.

Compiler Options
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Paths Compiler I Targetl
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Select which one that suits you.
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Starting a new Project:

Once the compiler options are setup, a new project can be created. Click Project
menu — New.
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The ICC12 will prompt to save the new project. The user should decide whether
to create a new directory to save the new project. In this example a new
directory called Test is created and the file is saved as file test.prj.

Save Mew Project As... llil

Save in: | < Local Disk [C:] | e @ ek E-

Temp [Chusr

Templ () WINDOWS

Tempz W UTemp

Temp4

Temps
: [+
File name: | Open I
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Type the filename as test.prj and click on the Save button.

S ave in: Ilal Test j = 5% ER-

File name: Itest.pri |i|
Save as bype: IF'ru:uieu:t Files [*.prj) j ﬂl

Note that the project window has changed to add Files, Headers and Documents.
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Creating a new file to the project:

To add files to the project, click on the File menu — new as shown.

* ImageCraft IDE for ICC12 (PROFESSIONAL)

File Edit Search Wiew Project RCS  Tools Terminal Help

I o6 & & D 5 EE

Reopen... 3

Open...
Reload. .. 2

SavE Chrl+5
Save A5,
Close

Compile Fle. .. »

Save &l
Close All

Print

Exit

Proiect | Browser |

-2y Files
23 Headers

-2y Documents

[[Ho Open File 1 [ChTestutest pri

[518

Note that ICC12 created an untitled file. Save the file as BlinkLED.C.
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ICC12 will open an explorer window to help save the file. Type BIinkLED.c then

press the save button.

Save in: IB Test j - £ Ea-

File name:

Save I
Save as type: IS:::ur-:e Files [*.c; *.2) j Cancel |

Note that ICC12 has renamed the file to BlinkLED.c.
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To add BlinkLED.c to the Project, click on the Project menu — Add File(s)
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ICC12 will open an explorer window to help and locate the file of interest.
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Note that the right window pane has changed to include BlinkLED.c under the

Files Project.
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Locate vectors.c and copy file to Test directory. The major reason why this

must be done is because of project to project dependency. Itis not good to keep
editing a single vectors.c if other projects are using this same file. It becomes a
problem to keep track of the changes made to the different projects.

To add vectors.c to the Project, click on the Project menu — Add File(s)

Loak in: Il.ﬂI Test
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Note that ICC12 has changed to include vectors.c Itis important to note that the
vectors.c was written for the 68HC912B32 and 812A4 MCUs. One should edit
the file to include other ISR addresses for the 912D60. This example edits the
line #pragma abs_address:0xffd0 to #pragma abs_address:0xdfd0

The original vector address OxFFDO is changed to OXDFDO. This is because the

FLASH Loader resides from $E000 to $FFFF.
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*to

* 3CIHandler,

*

#if defined| HC12)
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*f

#praga nonpaged function start

fendif

extern void start{veid);

/* entry point in cre??.s
fdefine DUMNY ENTRY (void (*) (void))OxFFFF
#pragma gha_address: Oxdfdo
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*f
void (*interrupt vectors[]] (veid) = o
{
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Write the codes below into BlinkLED.c file. Once it is written we can then

compile/make/build the code.

*" ImageCraft IDE for ICC12 (PROFESSIONAL)

Fie Edt Search Yiew Project RCS Tools Terminal Help

N5H9/+ L6 8 gdaEE

BlkLED ¢ |

finelude "912d60. 0"

void hlink delay(veid);
void main()
{

int i

DIRG = OxFF;
PTG = OxFF;

hlink delay();

while (1]

PTG = DxfF; {{LED on
blink delay();
PTG = 0x00;

blink delay|);

{{LED off

void blink delayivoid)
{
int i
for (i=0;1+64000; 144
{

| »

Froject | Browser |

BV

5@ Fles
- BinkLED
0 vectors.c

- Headers

------ £) Documents

iy Modifed CATestBliklED.c

CATesttestp
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#i ncl ude "912d60. h"

voi d blink _del ay(void);
voi d main()

{ o
Int 1I;
DDRG = OXFF
PORTG = OxXFF;

bl i nk_del ay();

whi | e(1)

PORTG = OxFF; // LED on
blink _del ay();
PORTG = 0x00; /[ LED of f
bl i nk_del ay();

}

voi d blink_del ay(voi d)
L
int i;
for(i=0;i<64000;i ++)
{

}



Compiling/Build/Make the file:

To make the file click Project menu — make project as shown.
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File Edit Search Wiew | Project RCS Tools Terminal Help
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#include 9 Close &ll Files

Reopen... »
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void maini) Make Project Fa |
i Rebuild All Shift+F3
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Add Topmost Spened File
DDRG =
Remove Selected Filels)
PORTG =
Opkions. ..
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hite . dese
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FPORTG = OXFF:
blink delayi():
FPORTG = Ox00; A/ /LED off
blink delayi():

A/LED on

H

roid blink delayiveid)
i
int i:
for(i=0;1<64000; i++)
{

|

Done .
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{ < BlinkLED.c
.4 vectors.c
23 Headers
----- £ Documents

18: 43 |C:\Test\BlinkLED.c
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Note the bottom window pane will show messages to display how the build
progressed. Any errors, if any, are shown in this window. The build was without
error so we can progress to erasing and programming the 912D60/A.

*  ImageCraft IDE for ICC12 (PROFESSIONALY
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BlinkLED.c |

woid maini)
1
int i;

DDRG = OxXFF:
PORTG = OxFF;

blink delay():
while (1}

FORTG = OxFF:
blink_delawv():

PORTG = Ox00;
Blink_delsy();

SALED on

fFLED off

H

void kblink_delayivoid)
i
int i;
for (i=0;1i<62000; i++)
{

L

=l

Cihicehbind imakew —-f cest.mak

Done.
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Note the other extraneous files are created after a make.

i
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g m[:l C;I QB"I‘IkLED._C 1KEBE _CFile 10/z21/z004 3., 10jz1fz0

E5p !@ BlinkLED.c 1 KB C source file 10/21/2004 3:...  10J21/2(0
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‘ = vectars.dpz OKE DPZ File 10/21/2004 31...  10/21/2
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Using WordPad to check the content of test.s19 file. Note that the S-records are

of different lengths.

S10E1000CF080016107087CEO2008E8F
S110100B020027056A000820F6CE1075CDFE
S111101802008E10752706180A307020F51697
S1071026102A20FEGA
S110102A34B7751B9EC6FF7B002AC6FF7BF2
S11010370028161052200EC6FF7B0028165C
S1111044105279002816105220F0B757303D9%4
S111105234B7751B9ECCO00006C1E2007EC1EEC
S1111060C300016C1EEC1E8BCFAO0025F2B7577B
S105106E303DO0OF
S111DFDOFFFFFFFFFFFFFFFFFFFFFFFFFFFFAD
S111DFDEFFFFFFFFFFFFFFFFFFFFFFFFFFFF3F
S111DFECFFFFFFFFFFFFFFFFFFFFFFFFFFFF31
S109DFFAFFFFFFFF100011
S10810701D0016073D00

S9031000EC




Examining S-record:

If one looks closely at the S-record one can see S1 to be of different lengths.
This is atypical S-record generated by ICC12. S1 records are programmed in the
$1000 - $DFFF memory blocks.

As stated previously, FLASH Loader occupies $E000 to $FFFF therefore the
vector address at below $E00O.

Note the content of the memory address at $DFFE:$DFFF is $1000, the RESET
vector.

S111DFDOFFFFFFFFFFFFFFFFFFFFFFFFFFFFAD
S111DFDEFFFFFFFFFFFFFFFFFFFFFFFFFFFF3F
S111DFECFFFFFFFFFFFFFFFFFFFFFFFFFFFF31
S109DFFAFFFFFFFF100011

The S-record below is the start of code. The content of address beginning at
$1000 to $1050

S10E1000CF080016107087CEO2008E8F
S110100B020027056A000820F6CE1075CDFE
S111101802008E10752706180A307020F51697
S1071026102A20FEGA
S110102A34B7751B9EC6FF7BO002AC6FF/BF2
S11010370028161052200EC6FF7B0028165C
S1111044105279002816105220F0B757303D9%4
S111105234B7751B9ECCO0006C1E2007EC1EEC
S1111060C300016C1EECIE8CFAQ0025F2B7577B
S105106E303D0OF



For the 912D60A, the S- records needs to be formatted for 64 bytes lengths.
Therefore SrecCVT program needs to be invoked to be used to reformat the S-
record. Under Project-Options and Compiler Tab add the following line at the

Execute Command after Successful Build line. Press Ok button then re-make
the file.

sreccvt.exe -d60a -0 out.s19 test.s19

Compiler Options x|

Faths  Compiler I Targetl

™ Strict &M5I C Checkings
v Accept Estensions [C++ comments, binany constants)

[ int size enum [for backward compatibiling
tacro Defingls]: IIndefine(z];

Output Farmat IMDthD|a 519 j

MOTE: Debug information for structure

members iz only generated by the
PRO wersion

Esecute Command After Successful Build:

grecoyvt exe -d60a -0 out 219 test 219

Cancel | Setbs Defaultl Load Defaultl Help |

Note that test.19 is the original S-record and out.s19 is the file to be uploaded to
the MCU.



Programming the Adapt912DT60:

Open ICC12 terminal window by Selecting Show Terminal Window. Connect
Serial cable to any available PC COM port and the other end to Adapt912DT60.

* ImageCraft IDE for ICC12 (PROFESSIONAL)
File Edit Search Wiew Project RCS  Toals | Terminal Help

e = N = e

BlinkLED.c |

=]

Clear Window

Zapture

Fflnl::lude rolzde0.

void blink delayiwvoid);
void maini)
i

int i:
DDRG = OxFF:
PORTG = OXFF:

blink delayi():

swhile (1)

PORTG = OxFF:
blink delayi);
FORTG = 0Ox00;
blink delaw():

¥
void blink delayivoid)

{
int i;

S/LED on

A /LED off

Done.

<
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S—Record File Conver=ion Complete

Praject I Browser |
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£3 Headers
£3 Documents
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c
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Set the COM port parameters under Tools-Environment Options and then

Terminal tab.

*  ImageCraft IDE for ICC12 {PROFESSIOMNAL)

File  Edit
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Search  View Project

I_ Editor and Print Options

RCS | Tools Terminal Help
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|

Configure Tool
Run..

KN ]

i’ Download File:
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Download! |

Open Com Port I

Show Editors I

Done.

<

Converting S—Record File: test.s19

S—-Record File Conversion Complete

o

Froiect | Browser |

=-I¢€ TEST
=& Files
isZ BlinkLED
L vectars.c
£ Headers
£ Documents

[

[T erminal Windove
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Select the COM of your choice, BAUD = 9600, Flow Control = None and ASCII
Transfer Protocol to Wait for * (Flash). Press OK button to continue.

Environment Options

Preferences  Terminal |

COM Part——— Flows Contral
= COM 1 f More
 COM 2 = Hardware [CT5/RTS)
" COM 3 { Saoftware [*5/70)
= COM 4 " Eeep DTR Active
B audrate:

-

S T— | &% wiait for " [Flash]

—ASCI Transfer Protocol———
" None

£ Line delay [mz.] I'“:I

x|

ok

Cancel | Help |

In the middle is the Open Com Port button. Click to connect.

* ImageCraft IDE for ICC12 (PROFESSIONAL)

File Edit Search ‘iew Project RCS  Tools
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ﬂ Download File:
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Download! |
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=& Files
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Converting 3-Record File: test.s19 -

S-Record File Conversion Complete

Done.
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Move SW1 Load/Run switch to Load. Power up unit or press the RESET button

if already powered up.

* " ImageCraft IDE for ICC12 (PROFESSIONAL) I [m[ 5
File Edit Search View Project RCS Tools Termingl Help
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N - Project | Browser
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2] precute Pogran (Pseudo Uector) Bowse.._| Gy BiEDs
-» Program External Ram & vectons.c
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— : ) Documents
Cloze Com Part |
Show Editars |
KIN LIJ
|
Converting S-Record File: test.s19 ﬂ
S-Record File Conversion Complete
Done,
a
|E:\Test\test.pli |518 4

| | [Teminal Window

Please note the in the 912D60/A the Flash modules are in 2 location. One is
below $8000, beginning at $1000 to $7FFF (Lower block). The other is at $8000
to $FFFF (upper block). The FlashLoader allows one to erase either Lower or
upper memory blocks. Since the code starts from $1000 and the Psuedo vector

at $DFDO, it is important that both blocks be erased.



Erase command:

The command to erase upper memory block is the letter U and L for lower the

memory block as shown.
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Programming:
To program select P command as shown.
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Under the Download File press the Browse button to help locate the out.s19 file.

Select out.s19 then press the open button.
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Once the correct file is selected, press the Download button to initiate upload to

Adapt912DT60
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A progress Bar will indicate that the file is being transferred.
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Once file transmit is completed a Programmed message will appear on the

screen as shown.
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Move SW1 Run/Load switch to Run and press the RESET button. The LED on
the Adapt912DT60 that is connected to PG7 will begin to blink.

This concludes the use of ICC12 with Adapt912DT60 to using the FLASH

Loader.



